
About Bookshelf Help

Welcome to Bookshelf 98 Help 
To find help on a subject, click the Contents button at the top of this screen, then click the topic you want. 

Or click Index to look at a more detailed list of the subjects covered in Help. In the Index tab you can also type the 
words you want to search for in the text box, and the index will scroll to the words you’ve typed. 

To return to the last topic you viewed, click Back.

To close Help at any time and return to Bookshelf, click File in the Help menu bar at the top of this screen, and then 
click Exit. 
Within a topic, click the colored jumps to switch to other topics.

Tips on using Help
You can arrange the Bookshelf and Help windows to allow you to work in the program while consulting Help.

You can move either window by clicking and dragging its top title bar. You can also resize the Help or Bookshelf 
windows by clicking and dragging a window border.    

See Also
Resizing the Bookshelf window



What is Bookshelf?

Welcome to Microsoft Bookshelf 98, the multimedia reference library that turns your personal computer into a rich 
resource of information, education, and entertainment. Whether you're writing a research paper, looking up trivia, or 
just browsing, Bookshelf's integrated features help you explore almost any topic. 
With Bookshelf, you can:

• Search the library of 10 reference books, or search a single book. Click here for an overview of searching with 
Bookshelf.

• Look up references, define words, and copy and paste articles and images while working in other Windows 
programs, using QuickShelf.

• Take your search online, with the new Go Online tab.

• Supplement your knowledge of a subject with images, videos, audio clips, animations, and 360º Views. Click here 
to find out more about searching for specific media types.

For more information about Bookshelf, try the following:

• Tips for the new user

• Overview - searching with Bookshelf

• Bookshelf Tips and Tricks

• About QuickShelf

• QuickShelf Tips and Tricks



Tips for the new user

If you’re new to Bookshelf, here are a few ways you can begin to explore:

• Bookshelf tour

An interactive tour of the Bookshelf screens and menus.

• Overview - searching with Bookshelf

Helpful advice on getting the most out of Bookshelf’s search capabilities.

• The overviews to the reference books

Almanac Encyclopedia

Atlas Internet Directory

Chronology Quick ZIP Code

Computer/Internet Dictionary Quotations

Dictionary Thesaurus



Menus tour

In the picture, click a menu to view more information.

See also
Shortcut menu tour



Search panel tour

The search panel contains three tabs—Search All, Find Media, and Go Online—that help you find information in 
Bookshelf and on the World Wide Web. To learn more about how a tab functions, click it below.



Options dialog box tour

Move the mouse pointer over the picture. When the pointer becomes a hand , you can click a region to view more 
information.

See also
Enabling and Disabling:

ToolTips

pronunciations

automatic spelling check

sounds

the Bookshelf start theme

the Parental Control option

Changing the color of jump text

Changing articles' text size



Quick ZIP Code tour

Move the mouse pointer over the picture. When the pointer becomes a hand , you can click a region to view more 
information.

See also
Finding address information

Overview - Quick ZIP Code

Quick ZIP Code tips



Shortcut menu tour

In the picture, click a menu command to view more information.

See also
Defining words instantly

Creating a shortcut to an article

Jumping to related articles

Copying and pasting



Advanced Search tour

Move the mouse pointer over the picture. When the pointer becomes a hand , you can click a region to view more 
information.

See also
Narrowing your search with Advanced Search



Books menu tour

In the picture, click a menu command to view more information.

See also
Browsing through articles



Edit menu tour

In the picture, click a menu option to view more information.



File menu tour

In the picture, click a menu command to view more information.



Tools menu tour

In the picture, click a menu command to view more information.



QuickQuote tour

Move the mouse pointer over the picture. When the pointer becomes a hand , you can click a region to view more 
information.

See also
Using QuickQuote



Help menu tour

In the picture, click a menu option to view more information.



Article panel tour

Move the mouse pointer over the picture. When the pointer becomes a hand , you can click a region to view more 
information.



What's new in Bookshelf 98?

New Books
Bookshelf now includes the Microsoft Bookshelf Computer and Internet Dictionary, with over 7000 definitions. And, 
from the makers of the world’s best selling encyclopedia, Bookshelf now features The Encarta 98 Desk Encyclopedia
as its encyclopedia.

New and Updated Content
This edition of Bookshelf has more than 2500 pictures; more than five hours of sound; and more than 100 videos, 
animations, and 360º Views. Sixty new maps have been added to the Atlas.

New Features
Bookshelf 98 contains the following new features:
• Simpler and more intuitive searching (see Overview - searching with Bookshelf)

• Bookshelf Premier Web Search, a fast and efficient way to search the World Wide Web

• A new media type, 360º Views

• QuickQuote, Bookshelf’s new quote wizard, which helps you find the right quote fast (see Using QuickQuote)

• An improved user interface (see the Bookshelf tour for a quick introduction)

• Contents pages added to the opening screen of each book, allowing for easy access to information about the 
books

• A new Parental Control feature that gives you the ability to hide potentially offensive words and articles

New Online Capabilities
• Bookshelf now features the Go Online tab, a powerful way to extend your search to the World Wide Web. 

• With Bookshelf Premier Web Search, you can limit your search to high quality Web sites which have been selected
by Bookshelf’s editorial staff. 

• Bookshelf 98 includes Internet Explorer version 3.02, Microsoft’s powerful Web browser, which you can install from
the Bookshelf CD (note that this is a separate installation).

Changes to QuickShelf
QuickShelf has been simplified and more fully integrated with other Windows 95-based programs, such as Word and 
Internet Explorer. Now you can access all of QuickShelf’s capabilities—such as QuickDefine, QuickQuote, and Find 

in Bookshelf—by clicking the QuickShelf  icon in the Windows 95 taskbar at the bottom of your desktop.



Overview
Quick ZIP Code

Quick ZIP Code, one of the options on the menu bar, provides a quick, easy way to locate the city, state, and ZIP 
code for most United States addresses. 

Use Quick ZIP Code to verify an address's accuracy, find states that have cities with the same name, search for the 
number of cities with a street address that matches your own, or locate cities that share a particular ZIP code. Once 
you've found the address information you need, you can copy it to the Clipboard and paste it into any other program. 

The city/state/ZIP code combinations that Quick ZIP Code provides reflect the postal addressing standards of the 
United States Postal Service. If you have occasions where your search results are not what you expect, it may be 
due to a discrepancy with what the U.S. Postal Service considers to be a correct address. For more information on 
partial-address searches, see Finding address information.

Note    Quick ZIP Code is also easily accessible in any windows program. Click the QuickShelf  icon at the far right
of the Windows taskbar, and then click Quick ZIP Code.

See also
Quick ZIP Code tips

State abbreviations

Using QuickShelf



Overview
Encarta 98 Desk World Atlas

The Encarta 98 Desk World Atlas contains eight views of the world, topographic maps of the world's continents and 
countries, and state and regional maps of the United States and Canada.

Bookshelf enhances the information with audio pronunciations of country, city, and U.S. state names; full-color 
examples of country and state flags; and audio clips of the national anthems for many of the world's nations. The 
Atlas is also linked to the Encyclopedia and the Almanac, so access to detailed information about a particular region 
is only a click away.

In the search panel, Atlas articles are designated with a red  icon.
For information about working with the Atlas, see Using the Atlas.
For information about the full version of the Atlas, see About Encarta Virtual Globe.

See also
Opening a book

Finding information about a place

Changing your view of the Atlas

Viewing the Atlas Legend



Overview
Internet Directory

Introduction
The Microsoft Bookshelf Internet Directory 98 is a guide to resources on the Internet, particularly the World Wide 
Web. Essentially it is a distillation of the best of the Internet, and its entries have been editorially selected for their 
quality and interest to Bookshelf users. The Internet Directory is a useful tool for the student, the researcher, the 
casual Web enthusiast—anyone looking for Web destinations. Each Internet Directory listing provides a brief 
description of the Internet resource, the type of resource it is, its intended audience, and a hot link you can click to 
start your browser and take you to the site. See Using the Internet Directory for more information about connecting to 
these Internet resources.

In the search panel, Internet Directory articles are designated with a light green  icon.

Internet Directory updates
Now in Bookshelf 98, you can access new listings online via a page in the Bookshelf Web site. These listings are 
updated monthly. To access the page, click the Help menu, and click New Internet Directory listings online.

Disclaimer
Some of the links or content presented in the product will take you to sites and content not controlled by Microsoft. 
The Web links and content are for your convenience only, and Microsoft does not endorse and is not responsible for 
any Web sites or other third party content other than Microsoft's. 

Other trademarks or tradenames mentioned herein are the property of their respective owners.

See also
Opening a book

Finding Internet sites by category

About Internet browsers and resources

Receiving Internet Directory updates

Finding Internet links



Overview
Roget's Thesaurus of English Words and Phrases

Longman's original Roget's Thesaurus of English Words and Phrases is a vast resource of over 250,000 words and 
phrases classified according to underlying ideas and meaning. Each entry contains many more related terms than the
typical thesaurus. This thesaurus can be an indispensable companion for writers and speakers and can help you 
expand your vocabulary, avoid repetition, or simply recall a word that has slipped your mind. 

The words and phrases in the Longman version of Roget's Thesaurus are categorized into six classes. Dr. Peter 
Mark Roget developed this classification system in the 1800s for the first thesaurus, and his system has proven 
capable of absorbing new concepts and new vocabulary. Dr. Roget used a logical progression from abstract concept, 
through the material universe, to mankind itself, culminating in what he saw as mankind's highest achievements: 
morality and religion. First published in 1852, this complete unabridged edition is fully revised to reflect the English 
language of the 1990s. 

In the search panel, Thesaurus articles are designated with an orange  icon.

See also
Opening a book

Finding articles by category

Finding synonyms for words



Overview
The American Heritage Dictionary of the English Language, Third Edition

The American Heritage Dictionary of the English Language, Third Edition brings you the richness of American English
with more than 350,000 definitions written in clear, exact language. In addition to over 16,000 new words, this edition 
of The American Heritage Dictionary includes over 500 Usage Notes, Regional Notes, cross-referenced Synonym 
Paragraphs, and a Pronunciation Key. This comprehensive Dictionary offers expanded historical information in more 
than 400 Word History paragraphs and also includes Indo-European Roots that allow you to trace our language back 
6,000 years to its origins.

Bookshelf enhances the information provided by The American Heritage Dictionary with images, audio and 
animations, pronunciations, and videos.

In the search panel, Dictionary articles are designated with a blue  icon.

See also
Opening a book

Defining words instantly

Determining a word's pronunciation

Listening to and disabling pronunciations

Enabling the daily word/quote



Overview
The Columbia Dictionary of Quotations

The Columbia Dictionary of Quotations contains more than 18,000 remarks, witticisms, judgments, and observations 
on 1,500 subjects that reflect the range of human experience. The quotations in this collection were spoken or written
by both the famous and the forgotten—figures modern as well as old—who collectively constitute the shapers of our 
modern cultural landscape. These memorable, funny, or profound quotations were chosen not for their familiarity but 
for their relevance in the 1990s.

Bookshelf enhances The Columbia Dictionary of Quotations with images and audio recordings of some of the people 
whose quotes are presented.

In the search panel, Quotations articles are designated with a green  icon.

QuickQuote
Bookshelf 98 now features QuickQuote, a fast and easy way to search for the perfect quote. For more information, 
see Using QuickQuote.

See also
Opening a book

Finding articles by category

Enabling the daily word/quote



Overview
The Encarta 98 Desk Encyclopedia

The Encarta 98 Desk Encyclopedia puts a world of knowledge at your fingertips with 16,000 entries on a wide range 
of subjects. A streamlined version of the popular multimedia Encarta Encyclopedia, The Encarta 98 Desk 
Encyclopedia is designed to work in combination with Bookshelf’s other reference works to provide you with quick 
reference to essential information. As in Encarta Encyclopedia, the information is enhanced with images, maps, 
charts, tables, audio clips and animations, musical examples, videos, 360º Views, and national anthems.

In the search panel, Encyclopedia articles are designated with a purple  icon.
For information about the full version of the Encarta Encyclopedia, see About the Encarta Encyclopedia.

See also
Opening a book

Finding articles by title or subject

Using tools to find articles



Overview
The People's Chronology

The People's Chronology is a compendium that documents social and historical events from 3 million years BC 
through 1995. Covering 30 distinct areas of human endeavor in more than 35,000 entries, The People's Chronology 
provides concise information about the milestones that have occurred throughout the ages. This reference work is 
both a quick portrait of the world and a chronicle of the people and events that have shaped it.

Bookshelf enhances the information provided by The People's Chronology with audio, animations, videos, and 
images.

In the search panel, Chronology articles are designated with a yellow  icon.

See also
Opening a book

Finding information about a year

Chronology categories



Overview
The Microsoft Bookshelf Computer and Internet Dictionary

The Microsoft Bookshelf Computer and Internet Dictionary is an online version of the Microsoft Press Computer 
Dictionary, Third Edition. This is a comprehensive dictionary of computer- and Internet-related terms and 
abbreviations, presented in an easy-to-use standard dictionary format. 

Bookshelf enhances the information with audio and images.

In the search panel, Computer and Internet Dictionary articles are designated with a blue-green  icon.

See Also
Opening a book

Determining a word's pronunciation

Listening to and disabling pronunciations



Overview
The World Almanac and Book of Facts 1997

The World Almanac and Book of Facts 1997 is a general reference book of statistical data, contemporary facts, 
geographic information, and trivia that provides up-to-date, reliable information on people, places, and events 
throughout the world. The entries in The World Almanac are organized into chapters. Each chapter is divided into 
categories based on a wide variety of subjects. Most categories are further divided into sub-categories of information.

In the search panel, Almanac articles are designated with a brown  icon.

Bookshelf enhances the information provided by The World Almanac and Book of Facts 1997 with images, 
animations, charts, graphs, maps, and calendars. Bookshelf divides Almanac articles into the following 13 chapters:

1996 Religion

Consumer Information Science and Technology

Economics Sports

Health Transportation

Language, Arts, and Media United States

Nations of the World World History and Geography

People

See also
Opening a book

Finding articles by category

Using tools to find articles



Using the Internet Directory

The Internet Directory provides a link to, and a brief description of, high quality Internet resources selected by our 
editors. These include:
• World Wide Web pages, Gopher, and FTP sites. To connect to these you must have a browser installed and an 

account with an Internet service provider (ISP). Click “Choosing an Internet service provider” on the Internet 
Directory content page for more information.

• E-mail mailing lists, announcements, and responders. These are e-mail services to which you can automatically 
subscribe if you use a compatible mail client. To install a mail client from your Bookshelf CD, see About browsers.

The following table lists all the types of Internet resources in the Internet Guide, and gives brief instructions for 
connecting to each one.

Resource type
and example How to connect

Web Link 
Redirection

World Wide Web site
(http://web.address.domain)

Clicking the address starts your browser and 
connects you to the site.

Yes

Gopher site
(gopher://gopher.address.domain)

Same as Web sites Yes

FTP site
(ftp://ftp.address.domain)

Same as Web sites Yes

e-mail announcement list
(mailto:listname@domain.name)

Clicking the address starts your Internet Mail 
program and places a message in your outbox 
to be sent. The message will be sent the next 
time you log on (or immediately, if you are 
already logged on). 

No

e-mail discussion list
(mailto:listname@domain.name)

Same as e-mail announcement list No

e-mail responder
(mailto:listname@domain.name)

Same as e-mail announcement list No

telnet
(telnet://bookshelf.microsoft.com)

Clicking these addresses will start a telnet 
application and connect you to the site, where 
you will need to log on. If there are no logon 
instructions, log on as “guest” or “anonymous” 
and use your e-mail name as a password.

Yes

MUD
(telnet://mud.name)

MUDs are also accessed using telnet 
applications (see above); however, they have 
complex usage requirements. See one of the 
online FAQ (Frequently Asked Questions) in the
Internet Guide for information on connecting to 
and using MUDs.

Yes

newsgroup
(news:newsgroup.name)

Clicking these addresses will start a newsgroup 
reader and connect you directly to the 
newsgroup.

Yes

dial-up
(512) 555-1212

These links are not hot in the Internet Guide. To
access these resources, you need a properly 
configured modem and a telecommunications 
program (e.g., Dial-up Networking in Windows 
95). In the telecommunications program, create 
a new connection to the phone number listed in 
the Internet Directory article, then dial that 

No



number to connect.

If you can't access a site
The Internet is always changing. Sites move, are renamed, and become very busy, in which cases you may not be 
able to access them. Bookshelf 98 includes a new feature, called Web Link Redirection, that automatically checks the
Internet Directory address that you are trying to access, and notifies you of any discontinuations, equipment failures, 
or address changes. For more about Web Link Redirection, see Updating Internet links.

Even with Web Link Redirection, however, there may be times when you can’t access a site. If an Internet Directory 
link does not work, try it again later—the site may be so busy that it can't accommodate you. If you cannot connect 
after several such attempts, assume that you cannot use this site for one of many reasons. For example, the name of
the site may have changed and therefore the link will not work.

See Also
About Internet browsers and resources

Updating Internet links

Finding Internet links



Changing your view of the Atlas
You can zoom in and out when viewing Atlas maps, increasing and decreasing the scale of the map. If an Atlas map 
is too large to fit on your screen, you can increase the size of the Atlas window by hiding the search panel. 

• To zoom in on an Atlas map, click regions, nations, or states. An expandable area can be identified by the zoom

 icon next to your mouse pointer.
• To zoom out on an Atlas map, click the Zoom Out button on the bottom of the article panel.
• To hide the search panel, click the Hide  button at the top of the search panel.
• To view the search panel, click its Show  button.

See also
Overview - The Encarta 98 Desk Atlas

Using the Atlas



Quick ZIP Code tips

If Quick ZIP Code is unable to find the address information you need, try the following:
• Check to see that the street name and/or city name are spelled correctly.

• If an address has a directional (N, S, E, W, NE, NW, SE, or SW) be sure to include it.

• Be sure the directional is typed in the correct location in relation to the street name or number. For example, if an 
address is 101 Main St. NW and you type 101 NW Main St., you will get either no results or incorrect results. 

• Try deleting some of the address criteria. Sometimes you will get better results if you don't narrow your search too 
much. 

• Be sure you're using the correct state abbreviation.

Note Quick ZIP Code provides city/state/ZIP code combinations that reflect the postal addressing standards of the 
United States Postal Service. If you have occasions where your search results are not what you expect, it may be 
due to a discrepancy between what the specified address indicates and what the U.S. Postal Service considers to be 
a correct address.

See also
Overview - Quick ZIP Code

Finding address information



Chronology categories

Each entry in The People's Chronology falls under one of the following categories:

Agriculture Literature
Architecture Marine Resources
Art Medicine
Communications and Media Music
Consumer Protection Nutrition
Crime Photography
Economics, Finance, and Retailing Political Events
Education Population
Energy Religion
Environment Science
Everyday Life Sports
Exploration and Colonization Technology
Food Availability Theater and Film
Food and Drink Tobacco
Human Rights and Social Justice Transportation

See Also
Finding information about a year



Displaying the Atlas Legend

Using the Legend, you can identify the symbols used in Atlas maps.
• To open the Legend from within the Atlas, click the Legend button on the bottom of the article panel below the map.

See also
Opening a book

Overview - The Encarta 98 Desk Atlas

Using the Atlas



State abbreviations

You can use the following United States state, territory, or military station abbreviations when using Quick ZIP Code.

AA Armed Forces Americas, except 
Canada

MO Missouri

AE Armed Forces Europe, Middle 
East, & Canada

MP Northern Mariana Islands

AP Armed Forces Pacific MS Mississippi
AK Alaska MT Montana
AL Alabama NC North Carolina
AR Arkansas ND North Dakota
AS American Samoa NE Nebraska
AZ Arizona NH New Hampshire
CA California NJ New Jersey
CO Colorado NM New Mexico
CT Connecticut NV Nevada
DC District of Columbia NY New York
DE Delaware OH Ohio
FL Florida OK Oklahoma
FM Federated States of Micronesia OR Oregon
GA Georgia PA Pennsylvania
GU Guam PR Puerto Rico
HI Hawaii PW Palau
IA Iowa RI Rhode Island
ID Idaho SC South Carolina
IL Illinois SD South Dakota
IN Indiana TN Tennessee
KS Kansas TX Texas
KY Kentucky UT Utah
LA Louisiana VA Virginia
MA Massachusetts VI Virgin Islands
MD Maryland VT Vermont
ME Maine WA Washington
MH Marshall Islands WI Wisconsin
MI Michigan WY Wyoming
MN Minnesota

See also
Overview - Quick ZIP Code

Quick ZIP Code tips



About Encarta Virtual Globe
Using the Encarta 98 Desk World Atlas in Bookshelf is a good first step in exploring the world. If you'd like to explore 
in much greater detail, try the full version of Encarta Virtual Globe. This multimedia CD-ROM includes more than one 
million locations and helps you explore the continents and countries, sights and sounds, cultures, and facts and 
figures that make up our world.

For more information about Encarta Virtual Globe, visit the Web site at http://www.encarta.com/ewa_us



About Encarta Encyclopedia
After using The Encarta 98 Desk Encyclopedia in Bookshelf, you might find you’d like to explore the full version of the
Encarta Encyclopedia. This comprehensive encyclopedia, on two CD-ROMS, features more than 30,000 articles, 
extensive multimedia content, and many online links and interactive features, allowing you to continue your research 
at even greater depth. 

For more information about The Encarta 98 Desk Encyclopedia, visit the Web site at http://www.encarta.com



Opening a book

When you start Bookshelf, the Articles list contains all articles from all books. You can narrow down that list by 
opening a single book, called a book filter. 

To open a single book
1 Click the Search All tab or the Find Media tab (note that it is not possible to open individual books in the Go Online 

tab).

2 Click the book selector bar atop the search panel. In the menu that appears, click the book you wish to open. 

The book opens and displays its contents page in the Article Panel, containing a brief description of the book and 
links to more information. The Articles list now shows entries from only that book, and the title bar above the search
panel indicates which book is open.

Note In the Search All tab, make sure the articles about option is selected. Otherwise you will not see the book’s 
entries in the Articles list. 

To open all books
• To access all of Bookshelf’s books, click the book selector bar atop the search panel. In the menu that appears, 

click All Books. The Articles list contains entries from every book. 

Note It’s easy to forget when you have a book filter on. If Bookshelf 98 detects that you aren’t getting the 
information you need, it will display a message suggesting that you switch to All Books. 

See Also
Overview - searching with Bookshelf

Search panel tour

Book menu tour



Copying and pasting

You can copy text from within an article or another program, and then paste that text into any text box in Bookshelf, 
including those in Notes. You can also copy an address, unit of media, or block of text from Bookshelf articles and 
use it in another program, such as your word processor.
• To copy Bookshelf text or images to the Clipboard, use your mouse to select what you want to copy. Click the right 

mouse button, and in the shortcut menu click Copy. 

• To select an image, double-click the image until a blue border appears.

Note    Enlarged images cannot be selected; press CTRL + C to copy enlarged images to the Clipboard.

• To copy selected text directly into Microsoft Word or PowerPoint, click the right mouse button. In the shortcut menu 
that appears, click Copy to and select the program into which you want to copy the text. 

Note    If you're copying and pasting a table into Word, you may need to reformat the text using Word's Text to 
Table command. For more information about converting text to a table, see the Word documentation.

• To copy pronunciations to the Clipboard, right-click the audio  icon and in the shortcut menu click Copy.
• To copy a Quick ZIP Code address to the Clipboard, click the Copy Address button.
• To paste text from the Clipboard, click the point in a document or other text file where you want the text or 
media to be inserted, and then click Paste in the Edit menu.

See also
Taking notes

Printing articles

Copying text or media into Word or PowerPoint



Printing articles

You can print part or all of an article's text. If you do not select text before you click Print, all of the article text prints.

To print all or part of an article
1 Open the article you want to print. If you want to print the entire article, go to step 3.

2 To print only a portion of the article, select the text with your mouse.

3 Click the File menu and click Print Article. The selected portion prints.

Note    The printed result may have a different appearance than the article on your screen depending on your printer 
and configuration. For example, fonts and special characters may print differently, and images may not print clearly. 
Also note that Bookshelf automatically includes a citation for the source of the article.



Taking notes

You can use the Note feature to keep track of articles and make notes to yourself, just as you might with a paper 
stick-on note in a book. While you're viewing an article, you can open the Note box and attach a note to that article. 
You can revise, add, and remove notes from within the Note dialog box.

To attach a note to an article

1 Click the Edit menu and click Note. 

2 In the box which opens, click Add Current Article to attach a note to the current article. The title of the article 
appears in the Articles list.

3 Type your comments, if any, in the Annotation box. 

4    Click OK. The Note box closes, and a note  icon appears to the right of the article's title in the article panel.

To go to an article to which a note is attached

• Open the Note box, click the title of the article in the Articles list, and click Go To. 

To view a note attached to an article

• Click the note  icon in the upper right corner of the article panel. The Note box opens with the current article 
selected and your comments, if any, displayed in the Annotations box.

To paste article text into a note

1 Copy the text to the Clipboard. See Copying and pasting.

2 Open the Note box, and then click the title of the article you want to annotate.

3    Click the Annotations box, and then press CTRL + V    to paste the text from the Clipboard. 

To remove a note from the Note box

• Open the Note box, click the title of the article you no longer want to annotate, and then click Delete. Your note on 
the article will be deleted, but not the article itself.

See also
Copying and pasting

Using tools to find articles



 Quitting Bookshelf
• To quit Bookshelf, click the File menu and click Exit.

Or
• Click the close  button in the upper right corner of the Bookshelf window.



 Registering your copy of Bookshelf

By registering your copy of Bookshelf, you ensure that you'll be notified of software updates.

To register your copy of Bookshelf
1 In the Help menu, click Subscribe and Register.
2 In the dialog box that appears, follow the instructions for filling out and mailing the form.

Or
2 To register electronically, click Subscribe and Register Online at the bottom of the dialog box and follow 
the instructions for registration only.
Note    If you subscribe to Bookshelf, your current copy is registered automatically.

See also
Subscribing to Bookshelf

Printing articles



Subscribing to Bookshelf

Our staff is hard at work compiling information for next year's Microsoft Bookshelf CD-ROM reference library. Now 
there's a convenient, no-risk way to keep your copy of Bookshelf current and get the latest, up-to-date information 
automatically delivered to you. Just sign up for a Bookshelf annual subscription.

To subscribe to Bookshelf
1 In the Help menu, click Subscribe and Register.

2 Follow the instructions in the dialog box that appears.

Or

• Click Subscribe and Register Online at the bottom of the dialog box and follow the instructions for subscribing.

See also
Registering your copy of Bookshelf



Defining words instantly

You can instantly get definitions of a word as you’re using Bookshelf. Simply double-click the word and the 
QuickDefine dialog box opens with the word’s definition. Words with more than one definition also have a browse 
control in the upper right corner of the QuickDefine box.
• To display a word’s definition in Bookshelf, double-click the word.

• To view the next definition in the QuickDefine box, click the right  arrow. To go back, click the left 

 arrow.

• To hear the word’s pronunciation, click the sound  icon next to the word.
• To close the QuickDefine box, click Close or click somewhere out of the box.

See also
Overview - The American Heritage Dictionary of the English Language, Third Edition

Defining words in Microsoft Word or PowerPoint

Defining words in any application with QuickShelf



Determining a word's pronunciation

In the Dictionary, you can view and even listen to the correct pronunciation of a word. The Pronunciation Key explains
the phonetic spelling of a word.

• To listen to a word's pronunciation, click the sound  icon next to the word.
• To view the Pronunciation Key, click the word's phonetic spelling, which is in colored text in parentheses. 

See also
Overview - The American Heritage Dictionary of the English Language, Third Edition



Searching in Bookshelf—Overview

There are two main ways of searching the Bookshelf reference library: 
• Searching by keyword, which is similar to scanning an index

• Full-text searching by word or phrase, in which you search for specific words, regardless of their context

To take advantage of the expanded search capabilities of Bookshelf 98, try conducting your search in the following 
order:

1. Choose All Books from the book menu atop the search panel.

2. Click the Search All tab, and make sure the articles about option is selected.

3. Type in the subject you’re searching (e.g., “mountain”). As you type, the keyword list scrolls to the closest match.

4. Click the plus sign ( ) next to the keyword that matches your search. An indented list opens, showing a list of 
articles indexed to that word, grouped by book.    Click an article to open it in the article panel.

5. If you haven’t found the information you’re looking for, click any of the further information categories that appear at 
the end of the indented list (not all categories will appear for every keyword). “Related Definitions” contains further 
entries from the Dictionary; “More Information” contains related articles from the Encyclopedia, the Almanac, and 
the Chronology; “Quotations” directs you to related articles in the Quotations; and “Internet links” finds further 
Internet Directory entries related to your search.

6. If you still haven’t found the information you are looking for, try clicking the jumps within the articles.

7. Then, if you still can’t find the information you’re looking for, click the articles containing x option in the Articles 
list. A new list opens, displaying up to 50 articles that contain your search word(s), ranked in order of most to least 
likely to be useful.

8. If you still don’t have the information you need, try narrowing your search with Advanced Search, or extending your
search to the Web. For the Thesaurus, the Internet Directory, the Almanac, or Quotations, you can also broaden 
your search using the Outline button.

See Also
Opening a book

Using tools to find articles



Finding synonyms for words

You can use the Thesaurus to look up synonyms—words similar in meaning—for a word you specify. This is 
particularly useful if you're trying to think of a word but can't; if you look up a similar word in the Thesaurus, its 
synonym list may include the word you want.

To find a synonym for a word
1 Open the Thesaurus.

2 Click the Search All tab in the search panel. The Search All page appears.

3 In the text box, type the word for which you want to find synonyms. As you type, the Articles list scrolls to the part 
of the alphabet you specify.

4 Click an item in the Articles list to view the Thesaurus article or a list of articles from which you can choose.

See also
Opening a book

Overview - Roget's Thesaurus of English Words and Phrases

Defining words instantly



Finding articles by title or subject

You can use the Search All tab to find articles by their keyword or title. A keyword list is similar to a book index.

To find an article by its keyword or title
1 To search all of Bookshelf, select All Books from the Book selector bar atop the search panel. If you wish to 

search a specific book, open the book you wish to search.

2 Click the Search All tab. The Search All page appears in the search panel, with the articles about option button 
automatically selected.

3 In the text box, type the name of the subject or article title you want. As you begin to type, the Articles list scrolls to 
the part of the alphabet you specify.

4 Click a keyword in the list (an entry with a plus ( ) next to it). The entry expands to show a list of articles in the 
current book, or, if you have selected All Books, a list of books with articles on that subject, and the first article in 
the list appears in the article panel. Click any article in the list to view it. 

Note    To collapse the keyword list again, click its minus sign ( ).

See also
Overview - searching with Bookshelf

Opening a book

Using tools to find articles



Finding articles that contain a word or phrase

With the Search All tab in the search panel, you can search for all Bookshelf articles that contain a specific word or 
words. 

To search for a specific word or words
1 To search all of Bookshelf, select All Books from the book selector bar atop the search panel. If you wish to 

search a specific book, open the book you wish to search.

2 In the search panel, click the Search All tab. The Search All page appears.

3 Click the all articles containing the word(s) option button.

4 In the text box, type the word(s) you want to search for and click Search Now or press ENTER. The articles 
containing the word(s) you typed appear in the Articles list. Click any title to view an article.

Note    If you want to search for multiple words as a phrase, put quotation marks (" ") around them. For information 
on more sophisticated types of searches, see Using search operators.

See also
Overview - searching with Bookshelf

Opening a book

Using tools to find articles

Narrowing your search with Advanced Search



Finding articles by category

You can search by category for articles in the Thesaurus, Quotations book, Almanac, and Internet Directory. When 
you open one of these books, the Outline button appears on the bottom of the article panel along the bottom of the 
article panel. The Outline box which opens contains a list of keywords, similar to a book index, in the currently 
displayed book. 
• To open the Outline dialog box, click the Outline button. If you have an article open, the article's category is 

selected. If no article is open, the beginning of the keyword list appears.

• To view the titles within one of the Outline's categories, click the plus sign ( ) next to the keyword.
• To hide the titles within a category, click the minus sign ( ) next to the keyword.

See also
Using tools to find articles

Overview - searching with Bookshelf



Finding articles that include certain media

You can use the search panel's Find Media tab to search for articles that contain audio, animations, video, images, 
or 360º Views.

To search for media
1 To search all of Bookshelf, select All Books from the book selector bar atop the search panel. If you wish to 

search a specific book, open the book you wish to search.

2 Click the Find Media tab in the search panel. The Find Media page appears.

3 If you are continuing a search, your search text appears in the text box. Otherwise, type in the word or phrase you 
wish to search for.

4 Select the type of media you wish to find. If you wish to search for all types of media, click All Media. The Articles 
list displays titles of the articles that contain the selected form(s) of media.

Note If you have a book filter on, only those media the book contains can be selected.

5 Click a title in the Articles list to view the corresponding article. 

See also
Opening a book

Search panel tour

Narrowing your search with Advanced Search



Finding information about a year

You can use the Chronology to learn about important events in a year you specify. The Articles list in the search panel
displays articles by both category and year. 

To search by year for a Chronology or Almanac article
1 Click the Search All tab. The Search All page appears in the search panel.

2 In the text box, type the year in which you're interested. The Articles list scrolls to the year you specify, and lists 
keywords for that year.

3 Click a year and keyword (an entry with a plus ( ) next to it). The articles list expands to show articles within that 
subject, and the first article opens in the article panel. 

Note    To collapse the subject again, click its minus sign ( ).

4 Click any article to open it in the article panel. 

See also
Overview - The People's Chronology

Using tools to find articles



Finding information about a place

In the Atlas, you can view a country or state's flag, listen to how the location's name is pronounced, listen to a 
national anthem, and jump to articles related to that location. You accomplish all of these tasks through the Atlas 
information dialog box, which you open by viewing a map and clicking on a location's name.

To search the Atlas for articles about a location
1 Click the Search All tab. The Search All page appears in the search panel.

2 In the text box, type the location’s name. The Articles list scrolls as you type.

3 Click the plus  next to the location’s name. In the indented list that appears, click the Atlas entry for the location.
A map containing that location appears in the article panel.

For information about navigating in maps and accessing Atlas information, see Using the Atlas tools.

See also
Opening a book

Overview - Encarta 98 Desk World Atlas

Using the Atlas
About the Atlas cursor icons



Finding address information

With Quick ZIP Code  ’  s   searching capabilities, you can search using portions of addresses and retrieve various kinds 
of information. For example, if you know part of an address, you can quickly find its ZIP code; if you know a street 
address, you can find a list of cities that have that address. The table below describes information that results from 
different partial searches.

If you type . . . Quick ZIP Code finds . . .

Street address and city All states and ZIP codes for that street/city combination.

Street address All cities, states, and ZIP codes with that street address.

Street address and state All cities and ZIP codes in that state for that street address.

Street address and ZIP 
code

The exact city and state for that street/ZIP combination.

City All states and ZIP codes for cities with that name.

City and state All ZIP codes for that city/state combination.

City and ZIP The state.

State All cities in the state and all ZIP codes for each city.

State and ZIP code All cities in that state with that ZIP code.

ZIP code All cities (and, in some cases, sections of cities) with that ZIP 
code.

See also
Overview - Quick ZIP Code

State abbreviations

Quick ZIP Code tips



Finding Internet sites by category

You can narrow down the number of Internet sites listed in the Internet Directory by using the Outline feature to 
search by category.

To search for Internet sites by category
1 Open the Internet Directory and click the Outline button at the bottom of the article panel.

2 In the Outline dialog box, click the category you want. Names of sites related to that category appear.

3 Click the name of a site to see more information about it. 

4 To go to a site, click its Web address (displayed in the article in colored text). Bookshelf starts your Web browser 
and connects you to the site.

Note Bookshelf online features require Internet Explorer 3.0 or later, or Netscape 2.0 or later. If you do not have a 
browser installed, when you first click a link or other online feature Bookshelf offers to install Internet Explorer for you 
from the Bookshelf CD. It also installs a mail client and a chat client that can be used with other Internet Directory 
links. See About browsers for more information.

See also
Opening a book

Overview - Internet Directory

Finding Internet links



Narrowing your search with Advanced Search

With Advanced Search, you can refine your search for articles by searching for media and article types, searching 
only in certain books, and searching for certain combinations of words. You can combine criteria to narrow your 
search even more. For example, to find quotations by theologian Martin Luther, you could search for all articles in the 
Quotations book that contain the words “Martin Luther” but not “King”.

Note    Advanced Search is only available when the Search All tab is active.

To search using Advanced Search
1 Click the Search All tab. The Search All page appears in the search panel.

1 Click the Advanced Search button at the bottom of the search panel.

2 Follow the instructions in the Advanced Search dialog box to select the criteria for which you want to search.

3 When you've selected all of your search criteria, click Search Now or press ENTER. 

If any articles match your search criteria, the Advanced Search dialog box disappears and the titles of those 
articles appear in the Articles list.

If no articles match your search criteria, a message informs you of that fact, and you can try another search.

See also
Using tools to find articles

Printing articles

Using search operators

Overview - searching with Bookshelf



Jumping to related articles

You can move from one article to another in several ways:
• Inside an article, look for words or phrases in colored text, which are jumps to other articles in Bookshelf. Click the 

colored text to display that article.

Note    In the Internet Directory, World Wide Web and other addresses appear in colored text. When you click such 
addresses, your Web browser connects to that location and displays the site. See Using the Internet Directory for 
more information.

• Right-click a word in a Bookshelf article. On the shortcut menu that appears, click Find in and click a book in the 
book list. A list of articles that contain the word—and that are in the book you specified—appears in the search 
panel.

• In the Thesaurus, Quotations book, Almanac, or the Internet Directory, click the Outline button at the bottom of the 
article screen, browse through the outline, and then click titles to open their corresponding articles.

See also
Browsing through articles

Finding articles by category

Changing the color of jump text



Using tools to find articles

Many of Bookshelf's tools and books can help you find the article you want. 

To find articles
according to. . .

Use See this Help topic

their titles Search All tab Finding articles by title or subject

their subject Search All tab Finding articles by title or subject

their category Outline button Finding articles by category

words they contain Search All tab: 
all articles 
containing option.

Finding articles by searching for a word or words

year Chronology or 
Almanac books

Finding information about a year

location Atlas book Finding information about a place

media they contain Find Media tab Finding articles that include certain media

For searching in. . . Use See this Help topic

 the World Wide Web Go Online tab: Web
search

Searching with the Go Online tab

MSNBC news service Go Online tab: 
News

Searching with the Go Online tab

Encarta online library Go Online tab: 
Periodicals

Searching with the Go Online tab

For finding. . . Use See this Help topic

address information Quick ZIP Code Overview - Quick ZIP Code

Internet links The Internet 
Directory

Overview - The Internet Directory

quotations QuickQuote About QuickQuote

See also
Narrowing your search with Advanced Search

Overview - searching with Bookshelf

Using the search panel



Using the search panel

The top of the search panel contains a book selection bar, which allows you to choose the book or books you want to 
search. When you click this bar, a list drops down, containing the names of the nine books in the Bookshelf reference 
library. For more information, see opening a book.

Directly below the book selection bar are the three tabs, for three different types of searches. Clicking on one of the 
tabs displays the page for that type of search.
• When you start Bookshelf, the Search All tab is in front. This is the main tool for searching the nine books in the 

Bookshelf reference library.

• The Find Media tab allows you to narrow your search to articles that contain the media you specify: audio clips; 
images; or animations, videos, and 360º Views.

• The Go Online tab allows you to take your search to the World Wide Web.

Each of these tabs contains a text box at the top where you can type the word(s) for which you’re searching. The 
Search All and Find Media tabs also feature an Articles list, which displays the results of your search. Each keyword 
in this list expands to list articles and further categories related to that subject, much as a book index lists broad 
categories as well as more specific topics.

• To expand a subject, click the    plus ( ) symbol next to it. A list of articles about that subject appears.

• To collapse the subject again, click the minus ( ) symbol.

• To hide the search panel, click the hide  button.

See also
Overview - searching with Bookshelf

Search panel tour

Narrowing your search with Advanced Search

Opening a book



 Searching with the Search All tab

Use the Search All tab to search for articles by subject or text. One of the three search panel tabs, the Search All tab 
is the main tool for searching the Bookshelf reference library. You can use the Search All tab to search a single book, 
or the entire library.

There are two main ways to search using the Search All Tab:
• Searching by keyword, to find articles pertaining to a subject you specify

• Full-text searching by word or phrase, to find articles that contain a word or phrase that you specify

For tips on effective searching using the Search All tab, see Overview - searching with Bookshelf.

For information on more advanced searches see Advanced Search. 

See also
Opening a book

Bookshelf tour

Using the search panel

Search panel tour



 Searching with the Find Media tab

Use the Find Media tab when you are looking for articles that contain audio clips, images, animations, videos, or 360º
Views. One of the three search panel tabs, the Find Media tab narrows your search to articles that contain the media 
you specify.

To use the Find Media tab to search for an article
1 To search all of Bookshelf, select All Books from the book selector bar atop the search panel. If you wish to 

search a specific book, open the book you wish to search.

2 Click the Find Media tab in the search panel. The Find Media page appears.

3 If you are continuing a search, your search text appears in the text box. Otherwise, type in the word or phrase you 
wish to search for.

4 Select the type of media you wish to find. If you wish to search for all types of media, click All Media.

Note If you have a single book open, only those media the book contains can be selected. The Articles list displays
titles of the articles that contain the selected form(s) of media.

5 Click a title in the Articles list to view the article and its accompanying media. 

See also
Overview - searching with Bookshelf

Opening a book

Bookshelf tour

Using the search panel

Search panel tour



 Searching with the Go Online tab

Use the Go Online tab to extend your search to the Internet. One of the three search panel tabs, the Go Online tab 
provides links to these three types of Internet sources:
• Web Search    A link to Bookshelf’s Premier Web Search page, a tool for searching the best sites on the World 

Wide Web using Infoseek’s powerful search engine

• News    A link to Bookshelf Premier News service, a searchable online source for news 

• Periodicals    A link to the Encarta Online Library, a database of periodicals

To use the Go Online tab to search for information on the Internet
1 Click the Go Online tab in the search panel. The Go Online page appears.

2 If you are continuing a search, your search text appears in the text box. Otherwise, type the word or phrase you 
want to search for. 

To display a list of your last 10 entries, click the arrow to the right of the text box.

3 Click the button for the type of Internet search you want to perform. Bookshelf starts your browser and carries out 
the search.
Note    Bookshelf online features require Internet Explorer 3.0 or Netscape 2.0 or later. If you do not have a 
browser installed, when you first click a link or other online feature Bookshelf offers to install Internet Explorer for 
you from the Bookshelf CD. It will also install a mail client and a chat client that can be used with other Internet 
Directory links. See About browsers for more information.

4 Close your browser or press ALT + TAB to return to Bookshelf. 

See also
Searching the Web

Opening a book

Bookshelf tour

Using the search panel



Using search operators

Using the Advanced Search option, you can narrow the scope of a full-text search by searching for combinations of 
words. You can use search operators — AND, OR, NOT, and NEAR — to help define the type of search you want. 
Type the search operators between your search terms in either lowercase or uppercase letters (for example, "and" is 
the same as "AND"). You can also specify an exact phrase for which to search by enclosing that phrase in quotation 
marks (" ").

Searches using multiple operators are evaluated from left to right, like a math problem. You can use parentheses to 
specify a different order—operators within parentheses are evaluated first.

Note    Advanced Search won't look for common words such as "a", "and", and "the".

The operators work as shown below.

If you type . . . Advanced Search finds . . .

moon AND landing articles containing both the word "moon" and 
the word "landing”.

moon landing articles containing "moon" and "landing". 
Since AND is the default operator, the results 
are the same as above.

"moon landing" articles containing the exact phrase "moon 
landing".

moon OR landing articles containing "moon" or "landing" or 
both.

moon NOT landing articles containing "moon" but not "landing".

moon NEAR landing articles containing "moon" and "landing" 
where the two words are separated by eight 
or fewer words.    

See also
Finding articles by searching for a word or words

Narrowing your search with Advanced Search

Search panel tour



Browsing through articles

Using the browse controls on the lower right side of the article panel, you can browse through articles as you might 
turn the pages of a book. 

• To browse through topics in sequence in the current book, click one of the browse  arrows 
in the lower right corner of the screen.

• To backtrack through a list of articles you've previously viewed, click Backlist on the menu bar. A drop-down
list appears, displaying up to the last 20 articles in the order you viewed them. Click an article to view it again.

Note    When you first start Bookshelf, Backlist is unavailable until you go to your first article.

See also
Using tools to find articles

Jumping to related articles

Backtracking through articles



Backtracking through articles

With the Backlist option on the Bookshelf menu bar, you can easily return to articles you’ve previously viewed. 

To backtrack through previously viewed articles
1 On the menu bar, click Backlist. A list drops down, showing up to 20 of the most recently displayed articles, with 

the most recent at the top. 

2 Click an article you want to view. The article is displayed in the article panel.

Note If you have not yet viewed any articles, or have just started Bookshelf, Backlist is unavailable.

With a Microsoft IntelliMouse, you can quickly and easily browse through previously viewed articles. See IntelliMouse 
for more information on this and other Intellimouse features in Bookshelf.

See also
Creating a shortcut to an article

Browsing through articles

Using tools to find articles



Creating a shortcut to an article

You can create a shortcut that will allow you easily to return to any article.

To create a shortcut to an article
1 Right-click anywhere in the article.

2 In the shortcut menu that appears, click Create Shortcut.
Bookshelf will create a shortcut icon on your Windows 95 desktop. Clicking this icon automatically opens Bookshelf to
the appropriate book and article.
• To remove a shortcut from the desktop, right-click it and select Delete from the shortcut menu that appears.

See Also
Jumping to related articles

Taking notes



Changing the color of jump text

Using the Options dialog box, you can change the color of jump text or hotspots. 

To change the color of jump or hotspot text
1 Click the Tools menu, and then click Options.

2 In the Options dialog box, click the option button under the color you want and click OK.

Notes    “Jump hotspots” (default color = blue) refers to colored text that, when clicked, opens an entirely new topic. 
“Pop-up hotspots” (default color = red) refers to colored text that has an underline and opens an explanatory window 
when clicked.

If you click the Reset button, all of the options revert to their default settings.



Resizing

You can enlarge or reduce the size of the Bookshelf window by clicking and dragging its edge. You can also increase 
the size of the article panel by hiding or resizing the search panel. 

• To hide the search panel, click its Hide  button. 

• To view the search panel, click its Show  button.
• To resize the article and search panels, point to the divider between them and drag it to the position you 
want.

See also
Changing articles' text size



Changing articles' text size

Using the Options dialog box, you can change the size of article text. 

To change text size
1 Click the Tools menu and click Options.

2 In the Options dialog box, click a text size, and then click OK.

If you click the Reset button, all of the options revert to their default settings.

Note    You can see more of an article's text and images at one time by using your whole screen for Bookshelf. For 
information about resizing screens, see Resizing.

With a Microsoft IntelliMouse, you can quickly change the text size without leaving an article. See IntelliMouse  for 
more information on this and other Intellimouse features in Bookshelf.

See also
Accessibility options



Using keyboard shortcuts

You can use shortcut key combinations in place of the mouse for most operations in Bookshelf.    The following table 
shows the key combinations for activating menus, commands, and buttons.

Press To

ALT + shortcut key Open a menu from the menu bar (type the 
underlined letter in the menu name).

Shortcut key Choose an option in an open menu or an active 
dialog box (type the underlined letter in the 
option’s name).

F1 Open Help.

F2 Edit in the active field.

F7 Check spelling in the active field.

Left or right arrow Move among menus (when a menu is open).

Up or down arrow Move among commands (when a menu is 
open).

ENTER Choose the selected menu option.

ESC Cancel the selected menu. 

CTRL+ X Cut selected text and copy it to the Clipboard.

CTRL+ V Paste text or image from the Clipboard at the 
pointer's location.

CTRL+ C Copy selected text or image (or enlarged image)
to the Clipboard.

CTRL+ P Open the Print dialog box and print the selected 
portion of the text or, if no text is selected, the 
entire open article.

CTRL+ B See the previously viewed article.

CTRL+ SHIFT+ < Browse to the previous article in the current 
book, or the previous dictionary definition in 
QuickDefine.

CTRL+ SHIFT+ > Browse to the next article in the current book, or 
the next article in QuickDefine.

CTRL+ N Open the Note dialog box.

CTRL+ A Select all (if the pointer is in the Article window).

ALT+ N Display the next article in the Articles list.

ALT+ P Display the previous article in the Articles list.

ALT+ L Open the Backlist.

For Tabs in the search panel
Press To open



CTRL+ S Search All tab

CTRL+ F Find Media tab.

CTRL+ G Go Online tab.



Enabling and disabling the Bookshelf Daily word or quote

If enabled, the Bookshelf Daily feature displays a new quotation or word definition each time you start Bookshelf. The 
feature is enabled by default.

To disable the daily word or quote
1 Click the Tools menu, and then click Bookshelf Daily. 

2 In the Bookshelf Daily dialog box, clear the Show again at startup option, and then click OK.

To enable the daily word/quote
1 Click the Tools menu and then click Bookshelf Daily. 

2 In the Bookshelf Daily dialog box, choose either Word or Quote and select the Show again at startup option. 
Click OK.



Enabling and disabling sounds

You can use the Options dialog box to enable or disable Bookshelf's audio features— the audio pronunciations 
available in the Dictionary and Atlas, the interface sounds, and the Bookshelf start theme. Bookshelf sounds are 
enabled by default.

To open the Options dialog box
• Click the Tools menu, and then click Options. 

To disable Bookshelf audio pronunciations and interface sounds
• In the Options dialog box, clear the Enable Interface Sounds option, and then click OK. 

To enable Bookshelf audio pronunciations and interface sounds
• In the Options dialog box, select the Enable Interface Sounds option, and then click OK.

To disable pronunciations
• In the Options dialog box, clear the Enable Pronunciations option, and then click OK.

To enable pronunciations
• In the Options dialog box, select the Enable Pronunciations option, and then click OK.

To disable the Bookshelf start theme
• In the Options dialog box, clear the Enable Bookshelf start theme option, and click OK.

To enable the Bookshelf start theme
• In the Options dialog box, select the Enable Bookshelf start theme, and click OK.

See also
Audio troubleshooting



Enabling and disabling spelling check

Bookshelf runs a spelling check on the contents of the search panel’s text box whenever you click Search Now. Also,
if Bookshelf suspects that you have misspelled a word as you search, a box opens offering alternate spellings. These
spelling check options are enabled by default. 

Note    It’s a good idea to leave spelling check enabled, so Bookshelf can provide assistance when you search.

To disable spelling check
1 Click the Tools menu, and then click Options. 

2 In the Options dialog box, clear the Provide Automatic Spelling option, and then click OK.

To enable spelling check
1 Click the Tools menu, and then click Options. 

2 In the Options dialog box, select the Provide Automatic Spelling option, and click OK.

See also
Options dialog box tour



Enabling and disabling ToolTips

ToolTips are the labels that appear when you pass your pointer over screen objects. ToolTips are enabled by default.

Note    There is a special ToolTip in Bookshelf    that appears when you have a single book filter selected and 
Bookshelf detects that your search may be usefully expanded to other books in its library. For this reason, it’s a good 
idea to leave ToolTips enabled unless you have a specific reason for disabling them. 

To disable ToolTips
1 Click the Tools menu, and then click Options. 

2 In the Options dialog box, clear the Show ToolTips option, and then click OK.

To enable ToolTips
1 Click the Tools menu, and then click Options. 

2 In the Options dialog box, select the Show ToolTips option. Click OK.



Large Display Mode

Bookshelf 98 can run in a special large display mode for users who are visually impaired. In this mode, all text in the 
article panel is displayed in the largest available typeface, and the scroll bars double in size. Bookshelf will run in this 
mode automatically if it detects you have changed the settings in your Windows 95 Control Panel.

To enable large display mode by setting the default scrollbar size
1 In Windows 95, click the Start button, and then point to Settings. Click Control Panel. The Control Panel program 

opens.

2 Double-click the Display icon.

3 Click the Appearance tab.

4 Click the arrow next to the Item option, and then Click Scrollbar from the list.

5 Change the Scrollbar size to 24 pixels or higher.

6 Click OK. The new settings will be in effect when you restart your computer.

To enable large display mode by setting the High Contrast Display option
1 Open Control Panel as in step 1 above.

2 Click Accessibility Options.

3 Click the Display tab.

4 Select the High Contrast option.

5 Click OK. The high contrast mode will be in effect when you restart your computer.

Note    Both of the above options will affect the display of all Windows programs.



Accessibility Options

Bookshelf 98 contains several features to provide easier access for people with visual, hearing, or other impairments.
• You can set a special large display mode to run automatically, every time you run Bookshelf. 

• Within Bookshelf, you can set the article text size to a more readable typeface.

• For people who have trouble using the mouse, there are keyboard shortcuts for most mouse actions.

See also
IntelliMouse Features



Setting the Parental Control option

You can use the Options dialog box to enable or disable the Parental Control option. When this option is enabled, 
Bookshelf automatically filters out all content that contains words labeled by the American Heritage Dictionary's 
Usage Panel as either vulgar, obscene, or offensive. Any articles containing such words are dropped from the article 
list, and do not appear to the user in any form.

Note    When Parental Control is enabled, some non-offensive words may be hidden as a result of the filtering 
process. This feature is offered as an aid to parents, but Microsoft does not guarantee that all potentially offensive 
content will be excluded from Bookshelf or from the Internet resources accessed by means of Bookshelf. 

Parental Control can be enabled or disabled at any time by means of a password. By default, Parental Control is 
disabled when you first install Bookshelf.

To enable the Parental Control option
1 Click the Tools menu, and then click Options. 

2 In the Options dialog box, click the Parental Control button. A Password dialog box appears.

3 Type in a password of at least five characters. (See About passwords.)

4 In the second text box, type the password again to confirm. 

Note  Remember this password. You will need it to disable Parental Control again in the future. 

5 Click OK. The Parental Control dialog box appears.

6 Click the Enabled - hide sensitive content option button.

7 Click OK.

To disable Parental Control
1 Follow steps 1 through 5 above.

2 In the Parental Control dialog box, click the Disabled - show all content option button.

3 Click OK.

Note  If you forget your password, you can disable Parental Control by reinstalling Bookshelf.

See also
Changing passwords



Setting a password

To enable or disable Parental Control, you must set a password. This can be any combination of keystrokes of five 
characters or more. Be sure to make a note of this password, because you will need it if you want to change your 
Parental Control settings in the future.

For more information on passwords, see About passwords.



About passwords

When first typing your password for the Parental Control option, bear in mind the following:
• Valid passwords must contain at least five keyboard characters.

• Passwords are case-sensitive, so the combination of characters, including capitalization, must match exactly.

• You will need the password to change the Parental Control option in the future. Make sure that you keep a record 
of the password you assign. Otherwise, you will need to reinstall Bookshelf 98 to change the Parental Control 
setting.

See also
Changing your password



Changing your password

You can change your Parental Control password at any time.

To change your password
1 Click the Tools menu, and then click Options. 

2 In the Options dialog box, click the Parental Control button. A Password dialog box appears.

3 Type in your old password. The Parental Control box appears.

4 Click Change Password. The Password dialog box appears.

5 Type a new password of at least five characters. (See about passwords.)

6 In the second text box, type the password again to confirm. 

Note  Remember this password. You will need it to disable Parental Control in the future. 

7 Click OK to return to The Parental Control dialog box.



Finding Internet links

You can use the Internet Directory to find links to Internet resources, such as addresses on the World Wide Web, e-
mail mailing lists, and Telnet and FTP sites. 

To find a link to an Internet resource
1 Open the Internet Directory from the book selection bar atop the search panel.

2 Click the Search All tab. The Search All page appears in the search panel, with the articles about option 
selected.

3 Type a keyword in the text box. The Articles list scrolls as you type. (For more information about organizing your 
search, see Overview - searching with Bookshelf.)

4 Click a keyword in the list (an entry with a plus ( ) sign). The entry expands to show a list of articles related to 
that keyword, and the first article in the list appears in the article panel. Click any article in the list to view it. 

Note    To collapse the keyword list again, click its minus ( ) sign. 
5 In the Internet Directory, Internet links are displayed in a colored font. To follow a link, click it. Bookshelf starts your 

Web browser and connects you to the address you have chosen.    

Note    To access Internet resources and services, you'll need a Web browser and an account with an Internet 
Service Provider (ISP). For more information, click Guide to choosing an Internet provider in the Internet 
Directory contents page.
If you do not have a browser installed, when you first click a link or other online feature Bookshelf offers to install 
Internet Explorer for you from the Bookshelf CD. It also installs a mail client and a chat client that can be used with 
other Internet Directory links. See Using the Internet Directory for more information about the types of Internet 
Resources and directions on how to access them.

See also
Opening a book

About browsers

Searching the Web

Updating Internet links

Using the Internet Directory



Find in Bookshelf shortcut

When you install Bookshelf in the Windows 95 or NT 4.0 operating system, a new command is automatically added to
the Find menu. This command, Find in Bookshelf, provides an easy shortcut for starting Bookshelf from anywhere 
in Windows 95. Just click the Start button, point to Find, and then click Find in Bookshelf.

See also
Using QuickShelf



Integrating Bookshelf with Microsoft Word or PowerPoint

When you have Microsoft Bookshelf 98 and Microsoft Office 95 or later, you'll find that Bookshelf is conveniently 
integrated with Microsoft Word and PowerPoint.
• You can obtain instant definitions of words in a Word document or PowerPoint presentation using QuickDefine.

• You can copy entire articles or selected text and images from Bookshelf directly into these programs using the 
Copy to command.

• And, with the Look up reference command, you can quickly start Bookshelf to look up articles related to your Word 
or PowerPoint text 

See also
Using QuickShelf



Defining words from within Microsoft Word or PowerPoint

Bookshelf works with Microsoft Word or PowerPoint so that you can to look up words in the Bookshelf Dictionary with 
a click of your mouse. 

To look up the definition of a word while in Word or PowerPoint
1 Right-click the word you want to define.

2 In the shortcut menu that appears, click Define. The QuickDefine dialog box opens, displaying the word's 
Dictionary entry.

To see the next definition, if any, click the arrow in the upper right corner of the box.

See also
Overview - The American Heritage Dictionary of the English Language, Third Edition

Defining words instantly

Using QuickShelf



Copying text or media to Microsoft Word or PowerPoint

You can copy text or media quickly from Bookshelf to Microsoft Word or PowerPoint with the Copy to command on 
the shortcut menu.

To copy text or media to Word or PowerPoint
1 Use your mouse to select the Bookshelf text you want to copy. 

2 Click the right mouse button. In the shortcut menu that appears, click Copy to. 

3 Click the program into which you want to copy the text. 

If the program is open, you are asked if you want the text to be inserted in the current location or a new document. 
Otherwise, the program opens and the text is inserted in a new document.

Notes
• To select an image, double-click the image until a blue border appears.

• Enlarged images cannot be selected; press CTRL + C to copy enlarged images to the Clipboard.

• If you're copying and pasting a table into Word, you may need to reformat the text using Word's Text to Table 
command. For more information about converting text to a table, see the Word documentation.

See also
Using QuickShelf

Copying and pasting



Looking up references in Microsoft Word or PowerPoint

When you’re working in Microsoft Word or PowerPoint in Office 95 or higher, you can quickly switch to Bookshelf 
articles related to your document.

To look up references from Word or PowerPoint
1 In Word or PowerPoint, select the word or words for which you want to search.

2 Click the Tools menu in the program’s toolbar, then click Look up reference.

Bookshelf opens, with the text you have selected as the search text.

See also
Overview - searching with Bookshelf

Searching by keyword

Full-text searching by word or phrase

Defining words in Microsoft Word or PowerPoint



What is QuickShelf?

QuickShelf is a tool that helps you use Bookshelf with other programs. For example, while working in Microsoft Word,
you can select a word and look it up in the Bookshelf Dictionary without opening the entire Bookshelf program. You 
can find quotes or ZIP codes without leaving the program, and if you wish to open Bookshelf for more search 
features, QuickShelf provides you an easy way to do so. 

When you install Bookshelf 98, QuickShelf is added to your Windows 95 or NT 4.0 startup menu. From then on, 

whenever you start Windows, the QuickShelf  icon appears in the Windows 95 taskbar at the bottom of your 
Desktop.

See also
About the QuickShelf menu

Manually opening and closing QuickShelf



About the QuickShelf menu

Right-clicking the QuickShelf  icon brings up the QuickShelf menu, with the following options:
• QuickDefine

Brings up the QuickDefine box, with a definition of the currently selected word. 

• QuickQuote

Opens QuickQuote, allowing you to search for and copy quotations.

• Quick ZIP Code

Opens Quick ZIP Code, where you can search for ZIP codes and other address information.

• Find in all books

Opens Bookshelf, with the selected text entered in the search field.

• Close

Closes QuickShelf and removes the QuickShelf icon from the Windows 95 system tray.

• Help

Opens QuickShelf help.

See also
What is QuickShelf?



Using QuickDefine

With QuickShelf, it’s easy to define a word while you work in a Windows 95-based program.

To define a word using QuickDefine
1 Select the word.

2 Click the QuickShelf  icon in the Windows 95 taskbar. The QuickDefine window appears, containing the word’s 
definition. 

3 To hear the word’s pronunciation, click the audio  icon next to the word. To view the pronunciation key, 
click the word’s phonetic spelling, which is in colored text in parentheses.
4 Click anywhere outside the box to close the QuickDefine window and continue working.

See also
What is QuickShelf?

Finding information in Bookshelf using QuickShelf



Using QuickQuote

With QuickQuote you can quickly find a quotation on a topic and copy it into another application.

When you start QuickQuote from the Tools menu or from the QuickShelf menu, the QuickQuote window opens. Like 
the main Bookshelf window, this window is divided into two sections: the search panel to the left, and the larger article
panel to the right.

To find a quote with QuickQuote
1 In the text box at the top of the search panel, type a keyword or author, or select one from the scrollable topics list. 

2 Click Search Now, or press ENTER.

In the Category box on the top of the article panel, QuickQuote displays a list of categories that contain quotes 
relating to the keyword, or by the author you searched for. 

3 Click a category. QuickQuote displays the quotes in the box below.

4 Select the quote you want and click Copy. QuickShelf copies the quote to the Clipboard, where it is ready to be 
pasted into any other text-based Windows application.

See also
What is QuickShelf?



Using Quick ZIP Code

Use Quick ZIP Code to find a ZIP code for an address, to verify an address's accuracy, to find states that have cities 
with the same name, or to locate cities that share a particular ZIP code. Once you've found the address information 
you need, you can copy it to the Clipboard and paste it into any program. 

To use Quick ZIP Code in QuickShelf

1 Right-click the QuickShelf  icon.
2 Click Quick ZIP Code. The Quick ZIP Code box opens.
3 In the Street, City, State, and ZIP Code fields, enter the information you know. 
4 Click Find. 
5 Click Copy Address to copy the address information to the Clipboard.
For more information on ways of using Quick ZIP Code, see Finding address information.

See also
Overview - Quick ZIP Code

State abbreviations

Quick ZIP Code tips



Opening Bookshelf with QuickShelf

Use QuickShelf to access Bookshelf's reference books from any Windows 95-based application. By selecting a word 
before opening Bookshelf, you can automatically look up the word in the Bookshelf reference library; articles with that
word as their keyword appear in the article list when Bookshelf opens.

To open Bookshelf with QuickShelf
1 Select a word in a text-based program, or start with step 2, below.

2 Right-click the QuickShelf  icon in the Windows 95 taskbar.
3 In the shortcut menu that appears, click Find in all books. If you’ve selected a word to search for, 
QuickShelf starts Bookshelf with that word already in the text box. Otherwise, Bookshelf opens normally.
4 Close Bookshelf or press ALT + TAB to leave Bookshelf open and return to your running application.

See also
What is QuickShelf?

About the QuickShelf menu

Defining words with QuickDefine

Manually opening and closing QuickShelf



Manually opening and closing QuickShelf

When you install Bookshelf, the QuickShelf command is automatically added to your Windows 95 StartUp group, and 
the QuickShelf icon appears on your desktop every time you start Windows. 

However, if you should need to close QuickShelf for any reason, you can do it easily with the following procedure.

To close QuickShelf in the current Windows session

1 Right-click the QuickShelf  icon in the Windows 95 taskbar.
2 In the shortcut menu that appears, click Close. The QuickShelf icon disappears from the taskbar. 

To start QuickShelf again when it has been closed
1 Click the Start button, and then point to Programs.

2 Point to StartUp, and then click QuickShelf.
The QuickShelf icon appears in the Windows 95 taskbar at the bottom of your desktop.

See also
About the QuickShelf menu



Updating Internet links

Because the World Wide Web is constantly changing, Bookshelf 98 features new tools to help you keep up.

Updating Internet addresses that have been discontinued or changed
Internet sites change addresses, becoming discontinued or invalid, and new sites are always being created. 

Therefore, Bookshelf 98 includes a new feature, called Web Link Redirection, that automatically checks the Internet 
Directory address that you are trying to access, and notifies you of any discontinuations, equipment failures, or 
address changes. 

This feature is invisible to you unless a link has actually changed, in which case your browser will display a Web page
telling you the nature of the change and giving you access to the new address, if there is one. This way, as addresses
to Internet sites change, your copy of Bookshelf stays on top of the changes.

Note    Not all types of Internet resources are updated with Web Link Redirection. See the chart in Using the Internet 
Directory for a complete list of the Internet resources that Web Link Redirection handles.

Staying current with new Internet listings
Bookshelf 98 also provides a Web site to help you stay current with new Internet listings. This resource, updated 
monthly, lists addresses and links that are too new to have been included in your Bookshelf 98 CD.

To view links to new sites
1 Open the Help menu.

2 Click New Internet Directory Listings Online.

Bookshelf starts your Web browser and connects you to Bookshelf’s New Internet Directory Listings Web site. 

Note    Bookshelf online features require Internet Explorer 3.0 or later, or Netscape 2.0 or later. If you do not have a 
browser installed, when you first click a link or other online feature Bookshelf offers to install Internet Explorer for you 
from the Bookshelf CD. It also installs a mail client and a chat client that can be used with other Internet Directory 
links. See About browsers for more information.

See also
Overview - Internet Directory

Finding Internet links



Bookshelf Tips

See these Help topics for tips on using Bookshelf 98, expanding its capabilities, and taking advantage of its new 
features.
• Overview - Searching in Bookshelf

How to conduct an efficient Bookshelf search.

• Opening a book

How to narrow your search to a single reference book, or search all the books.

• Narrowing your search with Advanced Search

How to use search tools to further refine your search.

• Using the right mouse button

A time-saving shortcut to common Bookshelf commands.

• IntelliMouse enhancements in Bookshelf 98

Even more time-saving features for users of Microsoft IntelliMouse.

• Using the Bookshelf Backlist

How to return to articles you’ve previously viewed.

• Using the Bookshelf Daily feature

How to customize and work with the Bookshelf Daily.

• Using QuickDefine

How to define words with the click of a mouse.

• Using QuickQuote

How to find the perfect quote for any occasion with Bookshelf’s new quote wizard.

• Using the search panel

How to use the search panel, the main Bookshelf search tool.

• Integrating Bookshelf with Microsoft Word or PowerPoint

How to copy text, define words, and look up references quickly and easily with Bookshelf’s Office integration 
features.

• Searching the Web

How to use Bookshelf’s new online search features to search the Internet and the World Wide Web.

• Using the Atlas tools

How to get the most out of the new Encarta 98 Desk World Atlas reference book.

See also
QuickShelf tips



Using the Atlas tools

The Encarta 98 Desk World Atlas contains several tools for navigating maps and finding related articles and 
information.

For information on the Global view, see About Global view.

For information about changing your view of map details and enlarging the Atlas screen, see Changing your view of 
the Atlas.

For information about Map options, such as hearing pronunciations, displaying flags and related articles, zooming in 
on Atlas maps, and identifying disputed borders, see About the Atlas mouse pointer icons.

For information about the Atlas Legend, see Accessing the Legend.

See also
Opening a book

Atlas overview



About Global view

Bookshelf 98 contains thirteen world maps which, taken together, constitute a complete view of the world from 
several angles. From this view, you can click to zoom in on more detailed maps.

To display the Atlas Global view
1 Click the book selector bar and click Atlas. The Atlas opens with its contents page in the article panel.

2 Click “Link to the World Map” on the Atlas contents page. The world map opens to its default display of the Arctic 
Ocean.

To navigate in Global view

• Click the rotate control  to the lower left of the map.

To zoom in to more detailed maps

• Pass the mouse pointer over the map, and click when the pointer changes to the zoom  icon.

See also
Opening a book

Atlas overview

Changing your view of the Atlas.



About the Atlas mouse pointer icons

You’ll notice that the mouse pointer changes as you move the mouse over Atlas maps. Clicking at these times has 
the following effects:

• A  brings up a box with information about a country, its flag, and links to other books with information about that 
country.

• A  indicates that if you click here you can zoom in on the region under the pointer.

• A  indicates that you can click here to hear a pronunciation.
• A  indicates that the border under the pointer is disputed.

See also
Opening a book

Atlas overview

Changing your view of the Atlas.



Using the right mouse button

Clicking the right mouse button in the article panel brings up the shortcut menu, with the following options:
• QuickDefine

Brings up the QuickDefine box, with a definition of the currently selected word. 

• QuickQuote

Brings up the QuickQuote box, Bookshelf’s quote wizard.

• Copy

Copies the currently selected text to the Clipboard.

• Copy to

Copies the currently selected text to Microsoft Word or PowerPoint.

• Create Shortcut

Places a shortcut icon on your desktop, allowing you to jump immediately to the current article and book.

• Find in

Brings up a shortcut menu, allowing you to search for the selected text in one or all of the books.

Note    The right mouse button brings up a slightly different menu in QuickShelf. See Using the right mouse button in 
QuickShelf.



IntelliMouse enhancements in Bookshelf 98

If your computer has an IntelliMouse and IntelliPoint software installed, you can use it in Bookshelf to scroll through 
articles, lists, or anywhere there is scrollable text. You can also move quickly through previously viewed articles, and 
change the size of article text.

To scroll through articles and scrollable lists in Bookshelf
• Place the mouse pointer anywhere in the text and rotate the IntelliMouse wheel button to scroll. 

To cycle through previously viewed articles
• Place the mouse pointer in the article panel, press SHIFT on the keyboard, and rotate the IntelliMouse wheel button 

to cycle through previously viewed articles. (This is the equivalent of the Backlist command on the menu bar.)

To change text size
• Press CTRL and rotate the IntelliMouse wheel button to quickly change the text size in the article panel. (This is the 

equivalent of the Text Size setting in the Options box.)



About 360º Views

360° Views are a new media type in Bookshelf 98. When you open a 360º View, you see an image on your screen 
like any ordinary photograph or other image. By dragging the image area with the mouse, however, you can “move 
within” the image, as though you were standing in the middle of the scene and could turn your head to see the entire 
view. 

Note    The first time you open a 360º View, a dialog box will open and you will be asked to install the QuickTime 
viewer from the Bookshelf CD. Click OK to install the software on your hard drive and enable Bookshelf to display 
360º Views.    If you choose not to install the QuickTime viewer at this time, you can use Bookshelf normally, but you 
will not be able to operate 360º Views. 

To find 360º Views
1 Open the book you wish to search. To search all of Bookshelf, select All Books.

2 Click the Find Media tab in the search panel. The Find Media page appears in the search panel.

3 Click the Animations, Videos, and 360º Views option.

4 Click Search Now, or press ENTER.

To navigate in a 360º View.
1 Click the Expand button to open the image.

2 Move the mouse pointer to any point in the image area. 

3 Hold down the mouse button and drag the image to move within it. 

Note The display moves in the direction of the pointer’s position relative to the center of the image. To slow the 
movement down, move the pointer closer to the center of the image. 

The following Bookshelf 98 articles contain 360º Views.
Airport Traffic Control Landscape Architecture

Alps Machu Picchu

Blue Mosque Monet

Banff NASA

Building Construction New York

Egyptian Art Sculpture

Grand Canyon Vatican City

Great Wall Yellowstone

Istanbul

See also
Atlas overview

Changing your view of the Atlas.



Using the Bookshelf Daily Quote

The Bookshelf Daily is the box that appears when you first start Bookshelf, displaying a definition or quote chosen at 
random from the reference works. 
• To change from a daily word to a quote the next time you start Bookshelf, click the Quote tab. To change to a word,

click Word.

• To bring up the Bookshelf Daily box at any time, click the Tools menu and click Bookshelf Daily.

• To enable or disable the Bookshelf Daily, see Enabling and disabling the daily word/quote.

See also
About QuickQuote



About the Internet links in the Help menu

The Help menu contains links to Bookshelf Web sites on the World Wide Web. Click one of the links to start your 
browser and connect to the following:

Menu Item Connects to

Bookshelf Online The home page of the Bookshelf Web 
site

Bookshelf Tour Online An online guide to using Bookshelf 98

Bookshelf Game Online The game page at the Bookshelf Web 
site

Note Bookshelf online features require Internet Explorer 3.0 or later, or Netscape 2.0 or later. If you do not have a 
browser installed, when you first click a link or other online feature Bookshelf offers to install Internet Explorer for you 
from the Bookshelf CD. It also installs a mail client and a chat client that can be used with other Internet Directory 
links. See About browsers for more information.

See also
Searching the Web

Updating Internet links

Using the Internet Directory



Searching the Web with Bookshelf Premier Web Search

When you click the Web Search button on the Go Online tab, Bookshelf starts your browser and takes you to its 
Premier Web Search site. From here, you can perform two kinds of searches. Click the option buttons on the left-
hand panel of your browser to choose one of the following:
• Bookshelf sites. These are sites that have been editorially selected for inclusion in Bookshelf’s Internet Directory. 

To save time in finding your information, search these sites first.

• the whole Web. This type of search casts a wider net, but the results may be less useful. If you choose this search

type, sites included in the Internet Directory are marked with the Bookshelf  icon.

Search hints
To get the most out of your Web search, it’s useful to know a few rules. Check the following table to see how best to 
phrase your search text. 

Example Rule

Flood Capitalize a word to force a case-sensitive match.
To find all matches, leave it lowercase.

"beast of burden" Use quotes to identify phrases.

beast-of-burden Hyphens also indicate phrases.

Horsehead Nebula Adjacent capitalized words are treated as 
phrases.

Sartre, Sinatra Put a comma between unrelated proper names.

moons of +Jupiter
Put a plus ( ) in front of a required word or 
phrase to search only for text that contain the 
word.

virus -computer
Put a minus ( ) in front of an undesired word or 
phrase to search only for text that does not 
contain the word. 

Note Bookshelf online features require Internet Explorer 3.0 or later, or Netscape 2.0 or later. If you do not have a 
browser installed, when you first click a link or other online feature Bookshelf offers to install Internet Explorer for you 
from the Bookshelf CD. It also installs a mail client and a chat client that can be used with other Internet Directory 
links. See About browsers for more information.

See also
Searching with the Go Online tab



About browsers and resources

Bookshelf contains several tools for exploring the Internet and the World Wide Web, such as the Go Online tab and 
the Internet Directory. To connect to these Internet resources, you need a Web browser and an account with an 
Internet Service Provider. For information about choosing an Internet Service Provider, Click “Choosing an Internet 
service provider” on the Internet Directory content page for more information.

Browsers
Bookshelf 98 online features require Internet Explorer 3.0 or Netscape 2.0 or later. If you are using another browser, 
or an older version of these browsers, some Bookshelf Online features may not work properly, and you may not be 
able to view your search results. You can install Internet Explorer from your Bookshelf CD.

Note    If you do not have a browser installed at all, when you first click a link or other online feature Bookshelf offers 
to install Internet Explorer for you.

E-mail
You can use Bookshelf to send electronic mail if your mail client and e-mail reader support simple MAPI protocol. You
can install such a mail client from your Bookshelf CD by installing Internet Explorer. 

When you use Bookshelf to send an e-mail message (for example, by clicking on a link to an e-mail discussion list in 
the Internet Directory), Bookshelf will put the mail message in your outbox and will send the message the next time 
you connect to your service provider. For more information about MAPI protocol compatibility, see the documentation 
provided by your mail client and e-mail reader.

Note    If you're having difficulty accessing a newsgroup, check your browser to ensure that it's configured to a news 
server. If your service provider uses a news protocol that's incompatible with Netnews Transfer Protocol (NNTP), you 
may not be able to access newsgroups with your browser. Contact your service provider for more information. 

See also
Overview - Internet Directory

Using the Internet Directory

Installing Internet Explorer



About Internet Relay Chat

IRC (Internet Relay Chat) is an Internet protocol that provides for real-time chat sessions between connected users. 

Although the Bookshelf Internet Directory provides links to IRCs, in order to participate in them you must download 
and install an “IRC client.”    An IRC client is contained on your Bookshelf CD, and can be installed along with Internet
Explorer. See About browsers for more information.

Popular shareware sites, such as http://shareware.com, offer IRC clients free of charge. Download an IRC client 
appropriate for your operating system, and follow its directions to install and configure it for your Internet connection.

See also
Overview - Internet Directory

Using the Internet Directory

Installing Internet Explorer



Installing Internet Explorer

When you install Bookshelf 98 from the CD, all files necessary to run and use the program are installed automatically,
with the following exceptions:
• QuickTime viewer

The QuickTime viewer is a small program Bookshelf needs for running 360º Views. To save time during setup, this 
program is not installed until the first time you click a 360º View and try to open it. When you do so, a dialog box 
opens, asking you if you wish to install the QuickTime viewer. Click OK to install, or No to cancel or postpone the 
installation. Note that you cannot open 360º Views until you install this program.

• Internet Explorer

Although your Bookshelf CD contains Internet Explorer version 3.1, it is not automatically installed with the rest of 
Bookshelf. If you don’t have a browser, the first time you click an online link, Bookshelf will ask if you wish to install 
Internet Explorer. You can also install Internet Explorer at any time using the following procedure.

To install Internet Explorer from the Bookshelf CD
1 Turn on your computer and CD-ROM.

2 Insert the Bookshelf 98 disc into the CD-ROM drive.

3 In Windows 95, click the Start button and then click Run.

4 In the box, type the drive letter for the CD-ROM drive on your computer, followed by a colon (:) and \iexplore\
iexplore.exe (for example: D:\iexplore\iexplore.exe).

5 Follow the instructions that appear on your screen. Bookshelf installs Internet Explorer 3.1 and makes it your 
default browser. It also installs a mail client and a chat client that can be used with other Internet Directory links.

Note    If you have more than one World Wide Web browser on your computer, Internet Explorer will be made the 
default browser.

See also
Installing and removing Bookshelf



Installing and removing Bookshelf

If you need to reinstall Bookshelf for any reason (for example, you have forgotten your Parental Control password), 
you can do so by uninstalling Bookshelf and then installing it again, using the following procedures.

To uninstall Bookshelf:
1 Click the Start button, point to Settings, and then click Control Panel.

2 Click Add/Remove Programs.

3 In the dialog box that appears, click Microsoft Bookshelf 98 in the program list.

4 Click Add/Remove.

To install Bookshelf:
1 Turn on your computer and CD-ROM drive.

2 Insert the Bookshelf 98 disc into the CD-ROM drive.

3 Follow the setup instructions that appear on your screen.

See also
Installing Internet Explorer



Troubleshooting audio problems

No sound
If sound does not play at all, try the following:
• Be sure a sound card is installed.

• Check that a speaker is connected to the jack on your sound card not to the CD-ROM drive.

• Check the volume to be sure it is set at an audible level.

• In the Bookshelf program, make sure that the pronunciations and interface sound options are turned on. Open 
Bookshelf, click the Tools menu, and then click Options. In the dialog box that appears, the Enable Pronunciations 
and the Enable Interface Sounds options should both be checked.

• If the volume is turned up and you still hear no sounds, something may be wrong with your sound card installation. 
Check to see that the sound card drivers and necessary Windows drivers are installed correctly and reinstall if 
necessary. 

To check the installed drivers for Windows 95, click the Start button, point to Settings, and then click Control Panel.
In the Control Panel, double-click the System icon. Click the Device Manager tab and select Sound, Video and 
Game Controller from the list to see which sound card driver is installed.

To check the installed drivers for Windows NT, click the Start button, point to Settings, and then click Control Panel.
In the Control Panel, double-click the Devices icon. In the Devices box, look for your sound card driver on the list of
installed devices. 

• Make sure audio compression is installed and enabled.

Click the Start button, and then point to Settings. Click Control Panel, and then double-click Add/Remove 
Programs. Click the Windows Setup tab, select Multimedia from the list, and then click Details. Make sure that 
Audio Compression is checked.

• If the software is installed correctly, the sound card may need to be pressed more securely into its slot or have a 
jumper setting changed. Refer to your sound card documentation for more information.

• If you have both a sound board and special software that bypasses the sound board to play sounds through the PC
speaker or other sound reproduction device, we suggest you remove or disable the special software (i.e., the PC 
speaker driver). Bookshelf requires an MPC-compatible sound card to be installed and is not meant to run with the 
PC internal speaker or any combination of that speaker and special software.

Sound breaks up
If sound plays, but the audio breaks up or skips, the CD-ROM drive may not fully meet the MPC Level 2 specification 
for the Data Transfer Rate. The MPC 2 specification states that the CD-ROM drive needs to be capable of 
transferring data at a rate of 300 kilobytes per second while using 60% or less of the CPU. You can continue to use 
your CD-ROM drive to run Bookshelf, but will experience choppy audio and animation. 

To check the Data Transfer Rate and usage of your CD-ROM drive
1 Insert the Bookshelf 98 CD into the CD-ROM drive. 

2 Click the Start button, and then click Run.

3 In the box, type the drive letter for the CD-ROM drive on your computer, followed by a colon (:) and \msinfo32.exe 
(for example: D:\msinfo32.exe).

4 Click OK.

5 In the MSInfo32 dialog box, click the plus sign next to “CD-ROM”, and then click the letter of your CD ROM drive 
(e.g., D:).

6 Confirm that the value for Data Transfer Rate is more than 300K, and the value for CPU Util @ 300KB/s is less 
than 60%.

Sounds are cut off
Sounds may be cut off because of other sound-producing programs you have running. Your computer can play only 
one sound at a time, therefore other applications that produce sounds can interrupt the sounds in Bookshelf. Some 



sound producing programs can take over the audio capability and prevent other Windows programs from being able 
to make sounds. If you suspect you have such a program, do not run it at the same time as Bookshelf.

MIDI problems
Bookshelf sound media are located in the \books\mm directory of the Bookshelf CD in the form of MIDI (.MID) and 
Wave (.wav) files. You can test these files individually with the Media Player application included in Windows 95 or 
NT. 

To test a MIDI file with Media Player
1 Insert the Bookshelf CD into your CD-ROM drive.

2 Click Start, point to Programs, then Accessories, then Multimedia, and then click Media Player.

3 In the Media Player dialog box, click the Device menu, and then click MIDI Sequencer.

4 When the browse dialog box opens, find the directory that contains the MIDI file that you wish to play. Click the file 
to open it.

5 To play the file, click the Play button in the lower left corner of the Media Player box.

MIDI anthems and musical examples may sound softer than other audio. To increase the sound level, adjust your 
mixer settings. To do this in Windows 95, click the Start button, point to Programs, and then Accessories. Click 
Multimedia and then Volume Control. Adjust the MIDI volume level.



 Troubleshooting CD-ROM problems

Do not remove the Bookshelf compact disc from your CD-ROM drive while running Bookshelf. If Bookshelf cannot 
find the data files it needs to run, a message prompts you to correct the problem. 



 Improving performance

Microsoft Bookshelf uses the random access memory (RAM) of your computer to display pictures and play sounds, 
animations, and videos. If Bookshelf runs slowly or you see out-of-memory messages, Bookshelf may not have 
enough memory. The following suggestions may make Bookshelf run faster. 
• Bookshelf needs virtual memory enabled.

• Close all unnecessary applications.

• Defragment ("clean up") or optimize your hard disk by running a defragmentation program such as Disk 
Defragmenter, which is included with Windows 95. 

• Ensure that your CD-ROM drive is MPC Level 2. Check the documentation that came with your CD-ROM drive.

• Add more RAM to your computer. To run Bookshelf you need at least:

• 8 megabytes for Windows 95

• 12 megabytes for NT 4.0

      (Sometimes this value is listed as 8,192    or 12,288 kilobytes, KB, or K.) 

• Optimize the performance of Windows. For complete details, consult your Windows manual.

• If you are using Windows 95 make sure it is optimized for your CD-ROM drive. Windows 95 provides settings for 
CD caching and for accessing various CD-ROM drive speeds via the System Control Panel.

To review and modify the settings for your Windows 95 CD-ROM drive:
1 Right-click the My Computer icon on your desktop.

2 Click Properties.

3 Click the Performance tab.

4 Click the File System button.

5 Click the CD-ROM tab. In this box, make sure that the Supplemental Cache size is set to Large. Also, verify that 
the Optimize Access Pattern is correctly set for the type of CD-ROM drive that is installed on your system. (No 
single-speed CD-ROMs should be used double-speed, Quad Speed, etc.)



 Troubleshooting Printing problems

Printers differ in the way they use fonts, graphics, spacing, alignment, and character formats as well as in the way 
they process particular instructions. The appearance of your printed document can vary greatly from printer to printer.
The way your document looks depends on which format you assign and which formats your printer can print. If you 
encounter problems when printing from Bookshelf, such as no printout, poor print quality, or text being printed 
erratically, there are several ways to troubleshoot or correct the problem. The following topics provide basic 
information about solving problems when printing from Microsoft Bookshelf. 

Note    If the printer displays a message or an error indicator, see your printer manual for information about how to 
correct the problem.

Printer does not print at all
When a printer will not print at all, the cause is often a simple mechanical problem; that is, the printer may be offline 
or not connected to the computer. Verify the following:
• Check that the printer is plugged in and turned on.

• Check that the correct port is specified for your printer. 

• Make sure that you have the correct cable for your printer and that the cable is connected properly. 

• Check your printer setup: Click the Start button, point to Settings, and then click Printers. 

• Verify the printer information displayed.

• Try to print from another Windows application, such as WordPad.

Print quality is poor
If print quality is poor or "garbled," try one or more of the following steps to solve this problem. Try printing after each 
step before attempting the next one.
1 Copy the text you wish to print to a word-processing program such as Microsoft Word for Windows and print from 

that program. Printing from a word-processing program may, in some cases, produce better quality than printing 
directly from Bookshelf.

2 Reset the printer; turn it off and on again.

3 Reinstall the printer driver.

4 Check the printer setup: Click the Start button, point to Settings, and then click Printers.

5 Verify the printer information displayed.

6 If you have a serial printer, ensure that the serial com port baud rate and printer parameters are set to 
manufacturer's specifications. Decreasing the baud rate may solve the problem. 

To check the serial com port settings in Windows 95:
1 Click the Start button, point to Settings, and then click Control Panel. 

2 In the Control panel, double-click the System icon and then click the Device Manager tab. 

3 Double-click the icon for your serial com port, and then click the Port Settings tab.

4 Verify that the port settings match your printer manufacturer’s specifications.

Printing tips
The following tips about printer drivers may help you with printing problems:
• Many printers emulate industry-standard printers such as the Epson LQ, IBM Proprinter, or Hewlett-Packard 

LaserJet series. Consult your printer manual to see if your printer supports emulation. If it does, install the driver for
the printer it emulates in the Control Panel. 

• Your printer dealer or manufacturer may have a Windows printer driver for your printer. 

• If you have problems printing, try the Generic/Text Only printer driver. 

To install the Generic/Text Only printer driver



1 Click the Start button, point to Settings, and then click Printers.

2 Double-click the Add Printer icon and follow the instructions in the Add Printer Wizard to install the Generic/Text 
Only printer driver.

3 After the printer driver is installed, right-click the Generic/Text Only printer icon in the Printers Control Panel, and 
then click Set As Default in the shortcut menu.

4 Print from Bookshelf with this Generic/Text driver.



Troubleshooting Video Problems

If you are having display problems, try doing the following:
• Quit other programs to ensure you have enough memory.

• Switch to a video driver supplied by Windows 95 or Windows NT.

• Change to a different display mode. An alternative to using a different driver is to change your video mode to a 
standard video mode such as 640x480 resolution with 256 colors.

• Update your video driver to the latest version. Contact your video card manufacturer to find out the most recent 
version of the driver for your video card and how to obtain this driver. 

Note    Most companies post their latest driver on the Internet, which you may access via a World Wide Web 
browser or FTP application.

For details on how to change drivers or switch to a different display mode, see your Windows documentation.



Bookshelf tour

Move the mouse pointer over the picture. When the mouse pointer becomes a hand , just click to display more 
information.

See also
Menus tour

Search panel tour

Shortcut menu tour

Options dialog box tour



Articles list
Displays keywords and articles in an alphabetical list. Click the plus (+) next to a keyword to display a list of articles 
on that subject. Click the title of the article you want to display in the article panel.



Search All tab
Use to search for articles by title, subject, or words contained in the article. The Search All tab is visible in this picture.



Find Media tab
Use to search for articles that contain only the types of media you choose. See Find Media tab tour.



Go Online tab
Use to search the Internet. See Go Online tab tour.



Control menu
Click to display commands for minimizing, maximizing, and closing Bookshelf.



Book indicator bar
Shows which book is currently open.



Book selector bar
Click to see a list of all the books. Open a book (restrict your search to that book) by clicking its title. Or click All 
Books to search the Bookshelf library.



Show/hide search panel button
Click to show or hide the search panel. This button increases and decreases the size of the area in which an article is
displayed.



Article panel
This is where the article you choose is displayed.



Advanced Search button
Click to open the Advanced Search feature and use search tools to refine your search. (This button is only available 
when the Search All tab is displayed.)



Browse buttons
Click to display the next and previous articles in the current book.



Check spelling button
Click to check the spelling of word(s) you type in the text box.



Search Now button
Click to start a search for articles based on the text you’ve typed in the text box and the type of search you have 
chosen.



Text box
Type the word or words you want to search for here. To search for every occurrence of a phrase, put it in quotation 
marks.



Tools menu
Click to display a list of Bookshelf tools. See Tools menu tour.



File menu
Click to display the Print and Exit commands. See File menu tour.



Edit menu
Click to display commands for cutting, copying, and working with text. See Edit menu tour.



Books menu
Click to display a list of Bookshelf’s reference books. See Books menu tour.



Help menu
Click to display commands for getting Help on Bookshelf and connecting to Bookshelf sites on the World Wide Web. 
See Help menu tour.



Quick ZIP Code Command
Click to display the Quick ZIP Code feature. See Quick ZIP Code tour.



Backlist menu
Click to display a list of the articles you’ve recently viewed.



Find Media tab tour

Move the mouse pointer over the picture. When the mouse pointer becomes a hand , just click to display more 
information.



Go Online tab tour

Move the mouse pointer over the picture. When the mouse pointer becomes a hand , just click to display more 
information.



Search All tab
Use this tab to search for articles by title, subject, or words contained in the article. See also Bookshelf tour.



Multimedia type selection buttons
Click to choose the media type you want to search for. To search for all types click All Media.



Web Search button
Click to start your World Wide Web browser and search the Web with Bookshelf Premier Web Search.



News button
Click to start your World Wide Web browser and search MSNBC and other online news providers.



Periodicals button
Click to start your World Wide Web browser and search the Encarta Online Library periodicals database.



Control Menu button
Click to open the Control menu and display commands for changing the size and position of the window.



Print Command
Click to print the current article. See Printing.



Exit Command
Click to quit Bookshelf. See Exiting.



Search All Command
Click to use the Search All tab and search for articles by subject or words the articles contain.



Find Media Command
Click to search for images, audio clips, videos, animations, and 360º Views using the Find Media tab.



Go Online Command
Click to search sources on the World Wide Web using the Go Online tab.



Advanced Search Command
Click to refine your search using the Advanced Search dialog box. (This command is only available when the Search 
All tab is displayed.)



QuickQuote Command
Click to find quotes using Bookshelf’s quote wizard.



Daily Word/Quote Command
Click to display a word or quote with the Bookshelf Daily.



Options command
Click to customize Bookshelf features and change settings with the Options dialog box.



All Books command
Click to allow searching in all the Bookshelf books. (This is equivalent to selecting All Books on the Book selector 
bar.)



Dictionary command
Click to confine searching to the Dictionary. (This is equivalent to selecting Dictionary on the Book selector bar.)



Thesaurus command
Click to confine searching to the Thesaurus. (This is equivalent to selecting Thesaurus on the Book selector bar.)



Quotations command
Click to confine searching to the Dictionary of Quotations. (This is equivalent to selecting Quotations on the Book 
selector bar.)



Encyclopedia command
Click to confine searching to the Encyclopedia. (This is equivalent to selecting Encyclopedia on the Book selector 
bar.)



Atlas command
Click to confine searching to the Atlas. (This is equivalent to selecting Atlas on the Book selector bar.)



Chronology command
Click to confine searching to the Chronology. (This is equivalent to selecting Chronology on the Book selector bar.)



Almanac command
Click to confine searching to the Almanac. (This is equivalent to selecting 1997 Almanac on the Book selector bar.)



Internet Directory command
Click to confine searching to the Internet Directory. (This is equivalent to selecting Internet Directory 98 on the Book 
selector bar.)



Computer/Internet Dictionary command
Click to confine searching to the Computer/Internet Dictionary. (This is equivalent to selecting Computer/ Internet 
Dictionary on the Book selector bar.)



Copyright Information command
Click to view copyright information on Bookshelf 98.



Help command
Click to open Bookshelf Help.



About the [Current Book] command
Click to view information about the currently selected book.

Note This command is only available if a single book has been selected from the Books menu or the Book selector 
bar.



Keyboard Shortcuts command
Click to view a list of keyboard shortcuts.



Bookshelf Online command
Click to connect to the Bookshelf Online Web page.



Bookshelf Tour Online command
Click to connect to the Bookshelf Online Tour Web page.



Bookshelf Games Online command
Click to connect to the Bookshelf Games Web page.



Subscribe and Register command
Click to connect to the Bookshelf Web site, and to subscribe to receive future upgrades or register your copy of 
Bookshelf online.



About Bookshelf command
Click to display version, licensing, and copyright information about Bookshelf.



Address fields
Type the street address (for example, “150 Main St.”) in the first box. Use the lower box to enter the building number 
or apartment number if appropriate.



City, state, and ZIP code fields
Type just the city and state to find a ZIP code, or type a ZIP code to find the city and state where the ZIP code is 
located.



Find button
Click to search for an address matching the information you’ve entered in the fields above.



City, state, and ZIP code search results field
In this box Quick ZIP code displays city, state, and ZIP code recommendations for the address information you’ve 
entered in the fields above.



Copy Address button
Click to copy the current address to the Clipboard.



Cancel button
Click to close the box and return to Bookshelf.



Help button
Click to display Help on this feature.



Close button
Click to close the box and return to Bookshelf.



Search button
Click to search for the text you have entered in the text box.



Topics list
Displays a list of all QuickQuote categories, with the current one selected. Click a name in the list to select another 
category.



Categories list
QuickQuote displays all categories containing quotes that relate to the keyword you’ve typed. Click a category to 
display its quotes in the box below.



Quotes Found list box
QuickQuote displays your search results in the category you selected.



Copy button
Click to copy the quote you selected to the Clipboard.



Display All Quotations button
Click to display all the quotations found in your search.



Automatic Spelling checkbox
If this box contains a check mark, Bookshelf automatically checks the spelling of the text you type in the search panel
or Advanced Search box.



Enable Pronunciations option
If this box contains a check mark, Dictionary and Encyclopedia articles include written and audio pronunciations of 
words and phrases.



Enable Interface Sounds option
If this box contains a check mark, Bookshelf plays sounds such as pronunciations and music.



Show ToolTips option
If this box contains a check mark, Bookshelf displays descriptions of the screen as you move the mouse pointer.



Bookshelf Start Theme option
If this box contains a check mark, the Bookshelf Start Theme plays when you start Bookshelf.



Parental Control button
Click here to learn about Bookshelf’s Parental Control feature, to turn it on or off, and to create or change your 
Parental Control password.



Jump color option buttons
Click to change the color used in articles to indicate jumps to other articles.



Popup color option buttons
Click to change the color used to indicate text that you can click to connect to an Internet resource or display further 
information.



Text size options
Click a button to change the size of the text in Bookshelf articles.



OK button
Click to save changes you've made to Bookshelf options.



Reset button
Click to return the options to their original settings.



Hints button
Click to view suggestions for refining your search or making it more exact.



Book selection search options
Select the book or books you want to use in your search.



Media search options
Click one or more of the media types to limit your search to articles containing the types of media you choose.



Scope of search options
Click to choose the articles you want to search.
• To search through all articles in the current book(s), click All Articles.

• To limit the search to the current article, click Current Article Only. 

• To limit the search to the articles in the list generated by your last search, click Last Articles Found.



Reset button
Click to return Advanced Search to its default settings.



Search type option button
Click to choose the type of search you want. To search for keywords, click articles about. To search for articles 
containing a word or phrase, click all articles containing the word(s).



Advanced Search button
Click to refine your search by using search tools or to select specific books or media types to search.



Control Menu icon
Click to open the control menu with commands for moving or changing the size of the Bookshelf window. See your 
Windows online help for more information.



Window controls
Click to minimize, maximize, or close the Bookshelf main window. See your Windows online help for more 
information.



Articles list scroll bar
Click to move forwards or backwards in the Articles list. 



Previous search text button
Click to view a list of your recent searches. Click an item in the list to place it in the text box.



Contents page links
Click to display front matter, introductions, and reference material for the current book.



Contents page help links
Click to view the online help topic.



Contents page subscription and registration link
Click to register your copy of Bookshelf, or to subscribe to receive product updates.



Book title bar
Displays the short form of the title of the current book.



Book control buttons (Legend)
Click the buttons along this bottom bar (such as the Atlas Legend button shown here) to access information and 
perform actions specific to the current book. 



Book control buttons (Zoom)
Click the buttons along this bottom bar (such as the Atlas Zoom button shown here) to access information and 
perform actions specific to the current book.    



Browse buttons
Click to browse forward or backward through the articles in the current book.



Scroll bars
Click to scroll forward or back or from side to side in the current article.



Cut command
Click to cut selected text or media. (This command can only be used in parts of the program where text can be 
edited. At other times it is dimmed, as shown.)



Copy command
Click to copy selected text or media to the Clipboard.



Paste command
Click to paste text or media from the Clipboard into a text field. (This command can only be used in parts of the 
program where text can be edited. At other times it is dimmed, as shown.)



Copy to Word command
Click to copy selected text or media directly into a Microsoft Word document.



Copy to PowerPoint command
Click to copy selected text or media directly into a Microsoft PowerPoint document.



Note command
Click to attach a note to the current article.



QuickDefine command
Click to open the QuickDefine box with a definition of a selected word.



QuickQuote command
Click to search for a quote on the selected word or phrase with the quote wizard.



Copy command
Click to copy the selected text or multimedia item to the Clipboard.



Copy to command
Click to copy the selected text or multimedia item directly to a Microsoft Word or PowerPoint document.



Shortcut command
Click to create a shortcut to the current article on your computer’s desktop.



Find in command
Click to search one or all of the Bookshelf books for the selected word or phrase.



Copy to program options
Click to choose the Office program into which you want to copy the selected text.



Find Media tab
Click to open the Find Media search page (in the picture, this page is currently open).



Go Online tab
Click to open the Go Online search page (in the picture, this page is currently open).



QuickShelf tips

Now the resources of Bookshelf are a click away, any time you use a Windows-based program. Here’s how:

In any Windows program:

• Right-click the QuickShelf  icon in the Windows taskbar to get a definition, find a quote, complete an address, or
start a Bookshelf search on a selected word.

In Microsoft Word or PowerPoint:

• Right-click a selected word and choose Define from the Office shortcut menu.

• Choose Look Up Reference from the Office Tools menu to start a search on a selected word.

In Bookshelf:

• Right-click selected text or media to copy it to the Clipboard or directly into Word or PowerPoint. You can also 
create shortcuts or search the Bookshelf library.

See also



What is QuickShelf?

About the QuickShelf menu




